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What is Entourage?   

Entourage is Microsoft’s e-mail, task and calendar manager for Mac OS X that is 

packaged with Office 2008.  There are other programs officially supported at UT Austin 

that can also be used to read mail on the Exchange server, including Microsoft Outlook 

and Outlook Web Access.   When working from the office from a Mac or at home from a 

Mac, Entourage provides a great way to access and work with your e-mail.   

 Entourage 2008 boasts many convenient features which work in 

conjunction with Mac OS X to provide a convenient, productive and friendly work 

environment.   Entourage is a great program for individual productivity, while providing 

the security of storing e-mail and critical information on a central server that is regularly 

maintained by professional staff.    Since your e-mail is on a server, you can work with 

your e-mail and calendars from anywhere, including on the web through Outlook Web 

Access, which is very convenient should there be a problem with your Mac, or you have 

to work outside the office.   Moreover, when traveling, or having to check your e-mail 

from a computer you cannot trust, you can use Outlook Web Access at 

https://wmail.austin.utexas.edu.    

 For intense collaboration or working with other people’s calendars, especially 

those in executive roles, Outlook 2007 is a much more suitable package.  Fortunately, 

you do not need a Windows PC on your desk to access Outlook.  Rather, this can be done 

through a remote terminal session, or through a Virtual PC on your desktop!    

 This handout will focus on the use of Entourage 2008 used with UT Austin’s 

Microsoft Exchange Server 2007. 

Setting Up Entourage Profiles   

 

 Hopefully, Entourage 2008 is already set up on your machine.  If that is the case, 

then you can skip on to the next section.   

 

 For instructions on setting up Entourage to access your Exchange account on the 

Austin Exchange Messaging Service (AEMS) please visit 

http://www.utexas.edu/its/messaging/answers/entourage2008.php.  

 

 If you are using more than one Entourage profile, you will need to follow the 

instructions at http://www.utexas.edu/its/messaging/answers/entourage_multiple.php. 

Moving from Entourage 2004 to Entourage 2008   

 

 There are many differences between Entourage 2004 and Entourage 2008. The 

following list summarizes these changes: 

 

 Improved User Interface—Entourage now has a “Mac” look and feel and a more 

logical layout of menu items. 

 Help Feature—Use the new “Help” search box to find information you are looking 

for with online content and training available. 

https://wmail.austin.utexas.edu/
http://www.utexas.edu/its/messaging/answers/entourage2008.php
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 New Security Features—Entourage blocks bad attachments and “junk mail” better.  

A real bonus in conjunction with Austin Exchange spam blockers and your local 

anti-virus program. 

 Out of Office Assistant—This flexible feature now lets people know you’re away. 

 Super Fast “Advanced Find”—let you find messages quickly, just like Spotlight. 

 Improved HTML Display of E-mails—Now, you can read messages as they were 

sent by users. 

 Flagging Messages—You can put a message on your “To Do” list with an 

expiration date. 

 

 Overall, Entourage 2008 is a more reliable and pleasing product to use than 

Entourage 2004, with considerable gains in features and functions.  Microsoft is 

continually updating this product to add more tasks that it can perform.   Expect 

Entourage 2008 to get even better than it is today. 

 

Using Entourage 2008 In A Server Environment   

 

 Your local IT personnel have configured Entourage to work with Exchange 2007 

in order to bring you a number of convenient features.  These features are a departure 

from downloading and managing e-mail using applications such as Eudora because it is 

possible now to work with your e-mail from anywhere, including off of the web using 

such programs as Safari or Firefox.   (ITS provides Outlook Web Access for that purpose 

at www.austin.utexas.edu.) 

 One of the most important changes to using Entourage with ITS’s Exchange 2007 

services is that your e-mail and calendaring information are stored automatically in 

folders on the Exchange server.   Using mail rules, which are active while you are logged 

into Entourage, it is possible to automatically sort e-mail into folders, or even take 

additional actions when a specific e-mail is received.  (Behind the scenes e-mail rules that 

work whether or not you are using Entourage can be set up using Outlook 2007.)  

 With the use of the Exchange server, you can also save your address book on the 

server, and you have access to the e-mail addresses of every person who is on the Austin 

Exchange server.  Since the Austin Exchange service if now offered free of charge by 

ITS, this will eventually mean that most staff and many faculty will now be using this e-

mail system.  If you want to schedule a meeting with someone, you need to only find 

their e-mail on the Exchange Global Address list and then schedule a meeting.   

 
Starting Entourage 

 

 To start Entourage, simply click on the Entourage icon that should be placed on 

your desktop: 

 

http://www.austin.utexas.edu/
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Figure 1:  Entourage Icon 

 

 When you start Entourage, you should see the Entourage banner within a 

moment: 

 

 
Figure 2: Entourage Start-Up Screen 

Entourage Navigation And Terminology   
 

Entourage opens to display your e-mail messages with two main viewing areas: 

the Message and Preview Panes.  In addition, Entourage provides navigation features 

through View Buttons and the Folder List.  There are two search functions, one through 

OS X called “Spotlight” and one built-in, called Quick Filter.  For control and access to 

Entourage features, Entourage provides the top menu bar and also the Toolbar.  Finally, 

there is a quick access list called “My List”. 

 

 When you open up Entourage, a number of Windows open automatically.  These 

include the top-level Entourage menu, the main Entourage Window and optionally, the 

My Day window.    

 The top-level menu is always available while you are working with Entourage, as 

is typical for OSX, but will disappear if you are working with another program. 

 

 
Figure 3a:  Main Entourage Menu 
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Figure 3b: Main Entourage E-mail Screen 

 

 The main Entourage screen pops up automatically when you start Entourage, but 

can be closed at any time, while continuing to run Entourage in the background.   If you 

accidentally close this Window, you can restart this screen by running ViewGo 

ToMail.

Folder 
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My Day Window   

 Entourage provides the My Day window that allows you to see a summary view 

of the Event and To Do items that are due within the next few days.  This is a great 

productivity tool that integrates Tasks and Calendars into one convenient view.  To 

invoke My Day, simply click on the My Day icon wherever it appears on Entourage: 

 

 
Figure 4a:  My Day Icon 

 

 Once My Day is started, a PDA-shaped Window will appear on your screen that 

summarized “Events” and “To Do” items.   For exactly what appears on the “To Do” 

items and “Events”, read the sections on Tasks and Calendars respectively in this 

document. 

 

 
Figure 4b: My Day Display Showing Events and To Do Items 
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View Buttons   

 

Click on any of the View buttons to switch between Entourage features, including 

Mail, Address Book, Calendar, Notes, Tasks and Projects.  Keep in mind that only three 

items are currently synchronized with the Austin Exchange service:  E-mail, Calendars 

and Address Books.   All other features are stored locally in Entourage 2008.  

Note that if you flag an e-mail as a “to do” item, the task with a “to do” flag is 

also stored on the Exchange server.  Use the “To Do” Toolbar icon to manage flagged e-

mail messages, and sort using ViewFlagged Only.  

 

 

 

 

 

 
Figures 5a, 5b, 5c: Navigation Buttons 

Folder List   

 

Your Folder list is sorted into Entourage files stored on your hard drive and files 

stored on the Austin Exchange server. If you have not saved any e-mail files to your hard 

drive, you may wish to collapse that part of the list by clicking on the down arrow next to 

Folders on My Computer.  That way, you can more easily see the folders stored on the 

Exchange server. 

 

 
Figure 6:  Collapsed Folders List in Entourage 
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E-mail, Address Books and Calendars are stored under the Exchange Folder: 

 

 

 
 

Figure 7:  Folders and Entourage 2008 Features Stored on the Exchange 

Server 

 

The e-mail files on the e-mail server are sorted into four default folders: Inbox, 

Sent Items, Deleted Items, and Junk E-Mail. Any additional folders you have on your 

e-mail server will also appear. If you are on an Exchange server, you will also see a link 

to the Public Folders that are visible by all users on the server.    

 

While you can have additional folders anywhere under Exchange folders on the 

server, the best arrangement is to store additional e-mail folders under 

ExchangeInbox, additional calendars under ExchangeCalendar, etc.  To create 

additional folders choose File -> New -> Folder.  A dialogue will pop up allowing you to 

select where to place the folder.  To place the folder under the ExchangeInbox as 

recommended, you will highlight the Inbox and then click on OK. 
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Figure 8: Creating A New Folder 

 

 

Once a folder has been created, you can drag and drop messages into the folder 

from the Message List or create a Rule to automatically send messages to that folder as 

they are received.  Rules are discussed later in this document. 
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Reading and Sorting Messages   

 

 To read a message in Entourage, simply double-click the message on the message 

list.  Once you do that, you have several options: 

 

o Reply to the message sender 

o Reply to all message recipients 

o Forwarding A Message 

o Flagging a message for follow-up 

 

 Except for flagging a message for follow-up, all Reply and Forwarding functions 

are similar to those of composing a message in the next section, Composing New 

Messages.   

 

 The rest of this section will focus on sorting messages so they are easier to find.  

By default, the Entourage Message List displays messages in the order of Date 

Received, but can use any order you choose.    

 

 

 
Figure 9:  Message List 

 

The message list can be sorted in many different convenient ways to allow you to 

find a specific message quickly.  These include the following and more: 

 

 Received (default) 

 Priority 

 Attachment 

 From 

 Subject 

 Sent 

 To 

 Size 

 Folder 
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To sort messages in an order other that date (Received), for instance, click the 

Arrange by drop down list and choose how you would like the messages to be sorted. 

You can also specify whether the messages should be sorted in ascending or descending 

order by date by selecting “Newest on Top” or “Oldest on Top”.  By default, Entourage 

will also display messages by checking “Show in Groups”, which will attempt to 

subcategorize messages by Date, Name or other applicable name.   

 

        
Figure 10:  Sorting Messages  

Left Figure uses “Show in Groups”, Right Figure has “Show in Groups” unchecked 

 

 

Deleting Messages   

 

To delete a message using the Message List click once on the message to select it 

then click the delete button from the toolbar. You can also delete a message from the 

Message List by selecting the message and pressing the Delete key on your keyboard. 

Once you have deleted a message it will be moved to your Deleted Items folder on your 

e-mail server. To permanently delete a message you must also delete it from your 

Deleted Items folder. 

 

Previewing A Message in the Preview Pane   

 

To view a message in the Preview Pane click once on the message in the 

Message List. To open a message in a new window, double-click on the message in the 

Message List. 
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Figure 11:  Mail Message Preview Pane 
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Entourage Sending and Receiving E-mail   

Composing New Messages   

 

Entourage allows you to send e-mail to one or multiple people with a wide variety 

of attachments.  This section will cover finding the right e-mail address, composing the 

message and adding attachments.  Then, it will quickly review receiving messages. 

 

To compose a new message, click the New button in the main Entourage Mail 

toolbar. Also note the Reply, Reply All, and Forward buttons located in the toolbar.  

 

 
Figure 12:  Creating A New Message 

 

 

 

 

A new mail window will pop up immediately as illustrated below.   

 

 
 

Figure 13:  New Mail Messages Dialogue 

 

 

First, type in the Name or Address to send the e-mail to by clicking within the 

To, Cc or Bcc fields and then selecting the appropriate e-mail addresses.    After you 
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select your e-mail address, then, you will click on the message body itself and type in the 

subject and the message into the message entry area on the window.  When ready to send 

the message, click on Send. 

Entourage provides many options to finding and selecting e-mail addresses, these 

include: 

 

 “Cached” e-mail addresses 

 Your “Contacts” stored on Exchange (Address Book) 

 Your Address Book on your computer 

 Default Global Address List stored on Exchange 

 Directory (LDAP) 

 

Entourage stores previously used E-mail addresses that you can see immediately 

when you click on the To, Cc and Bcc fields in your e-mail. If you type a part of a name, 

the address appears as an aid to quickly select e-mail addresses.   These e-mail addresses 

that appear may or may not be correct, so use caution when selecting e-mail addresses 

this way (including Calendar contacts).  This “caching” feature can be turned off by 

going to the top Entourage menu and selecting EntouragePreferencesMail and 

News PreferencesComposeRecent Addresses and unselecting “Display a list of 

recently used addresses when addressing messages”.   If you select “Automatically check 

names when sending messages”, most errors in sending e-mail messages will be 

eliminated. 

Your “Contacts” are e-mail addresses stored on the Exchange server in your 

Address Book.   This is where you can store supplemental information for people whom 

you e-mail all the time, including people you invite to meetings.    

You can likewise, keep a local address book in Entourage.  This is important, 

because this is the only way to store information about Groups.   

 The most important lists for finding the e-mail addresses of coworkers are the 

Default Global Address List (GAL) and the Directory (LDAP).  The Default Global 

Address List has the e-mail address of everyone at UT Austin who is also using the 

Exchange server. You can not only send e-mail to these people, but you can include these 

people directly into scheduled meetings, a function to be addressed in a later section.  The 

remaining e-mail addresses for everyone affiliated with UT Austin will appear on the 

Directory (LDAP).    If cannot find a subscriber on the “GAL”, use the Directory.  If 

someone appears on both, use the GAL first. 
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These other options for selecting e-mail addresses are selected by clicking on the 

appropriate address book as illustrated below: 

 

 
 

Figure 14:  Selecting The Appropriate Address Book 

 

 

  After you select your e-mail address, then, you will click on the message body 

itself and type in the subject and the message into the message entry area on the window.  

 

 
 

Figure 15:  Composing a Message 

 

If you would like to attach a file to the message, click on Attach.  To insert an 

audio clip, photo or movie into a message, click on Insert.    
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In both cases, you will be presented with a dialogue that allows you select a file, 

or you can simply “Drag and Drop” your file into your e-mail. 

 

 
 

Figure 16:  E-Mail with Attachments and Photo 

 

When ready to send the message, click on Send. 

 

To receive a message, click on the Send/Receive icon.   

 

 
Figure 17:  E-mail Send/Receive Button 

 

Any e-mail that is waiting to be sent to you will be delivered to your Inbox for 

reading, unless it has been filtered using Mail Rules to another folder. 
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E-mail Signature   

 

You can create your own e-mail signature to be included on all new messages 

when you select the signature tab.  Under Entourage ToolsSignatures, you can create 

an E-mail signature that can be attached to every message you send.  Click on New and 

type in your signature, or simply “Drag and Drop” it from previously chosen text.  Then, 

close the window.  You will then be prompted to Save or Don’t Save the signature.  .   

 

 

 
 

Figure 18: Creating E-mail Signatures 

 

When you compose your message, there is a signature icon that will provide you a list 

of signatures to choose from.   

 

 
 

Figure 19:  Selecting an E-mail Signature 

 

Please note that signatures are not automatically included in Entourage e-mail.  You 

have to perform additional steps for this to happen. 

 

1. Go to ToolsAccounts on the main Entourage menu 

2. Under Accounts, double-click on the account to edit.  This is usually your EID, 

but could be something else, such as “Exchange”. 

3. Select the “Options” Tab and under Message Options, select the signature you 

wish to use by default.  The default signature is “none”. 

4. When done, click on the OK button (not shown). 
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Figure 20:  Selecting a Default E-Mail Signature 
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Finding and Managing E-mail   
 

Organizing Messages through Folders   

 

 The best way to organize and manage e-mail messages is through folders listed 

under the Inbox stored on the Exchange server.   Organizing messages in this manner also 

facilitates automatic sorting of messages according to a wide variety of rules, which will 

be covered in the next section.   A folder can have any name you choose and can be 

rearranged by “Drag and Drop” in any manner that is suitable to the kinds of messages 

you receive.  I could, for instance, move the folders and “Event Planning” to fall under 

“Professional Activities”. 

 

 
 

Figure 22:  Messages Can Be Organized Into Folders 

 

 Any message that you wish to move from your Exchange Inbox to a folder will 

be moved automatically to the folder you select when you “Drag and Drop” the message.   

The best steps to follow are listed below: 

 

1. Create categories under which messages will be organized, i.e., Todo, Done, 

Personal, Professional, etc. 

2. Create folders with these names under Inbox. 

3. Manually move messages under each category by using “Drag and Drop”.  It is 

possible to use message sorting and searching to organize messages in groupings 

that can be more conveniently moved. 

 

 Remember, dragging and dropping messages only work if you drop messages into 

folders on the server.  If you “Drag and Drop” the message to “Folders on My 

Computer”, the message is copied, not moved. 
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 A good arrangement of handling and managing e-mail messages is to immediately 

and proactively sort e-mail messages into folders using Mail Rules, which are discussed 

in the next section. 

 

Managing Messages through Rules   

 

You can set up rules in Entourage to sort your mail for you as it is received. You may 

want all mail from a certain sender to be delivered to a certain folder.  This feature can be 

used to store certain types of messages on your local machine to save server disk space. 

 Mail Rules work in two steps: 

 Matching A Message that meets one or more Criteria 

 Taking an Action on the message 

 

Messages can be matched on any of the criteria listed in this screen shot: 

 

 
Figure 23:  Message Rules Criteria 
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 Message actions can include any of the actions listed in this figure: 

 

 
Figure 24:  Message Rule Actions 

 

 To set up message rules to automatically sort or handle messages: 

 



Getting Started with Entourage  24 

1. Decide on the message categories and actions to take, for instance, the folders that 

will have to be created to automatically file messages and the criteria that will 

move a message to a folder. 

2. From the Tools menu choose Rules. 

3. Click the tab for the type of e-mail account you are using. In the case of Exchange 

server users, click on Mail (Exchange). (You must set up separate rules for each 

e-mail account you access through Entourage.) 

 

 
Figure 25: Setting Up Mail Rules 

 

4. Click New in the Rules window. 

5. Name your rule and specify the criteria that a message should meet in order for 

the rule to be executed. 

6. In the Then section, specify what actions should be performed on the messages 

that meet the criteria. 

This example has all E-mail from Bill Gates marked as not being junk e-mail and 

then is moved into a folder called “FromSupervisor”. 
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Figure 26:  Configuring Mail Rules 

 

7. Click OK. 

 

 Remember, in order for message rules to work, you must be logged into Exchange 

from Entourage.  Message rules do not work when you are logged out of your computer, 

including if your computer is turned off.  All messages otherwise will go to your Inbox.   

 

 Finally, to apply rules to your e-mails received before starting up Entourage, use 

MessageApply Rule. 

 

Best Practices Managing E-Mail With Entourage   

 

 There are some important things to do in managing E-mail that will help you in 

the long-term. 

 

 Avoid crowding your inbox with informational messages; categorize them in 

separate folders.  Keep your inbox clean. 

 Unless your job relates directly to technical support or customer support, schedule 

your e-mail reading for specific times of the day to get other things done first. 

 Never keep a message unless you are required to keep it, or it involves a repeating 

event, such as start of fiscal year activities. 

 There is no need to CC yourself because all messages you create will be in the 

Sent-Items folder anyway on the server. 

 Move all messages that require action to a “Todo” folder and scan it daily. 

 Keep all e-mail messages you write on a professional level.    

 Use Junk Mail Protection from ToolsJunk E-mail Protection, but check your 

Junk E-mail box often for legitimate messages. 
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Spotlight, Filters, Searches   

 

 Entourage and OSX on the Mac provide many different ways to locate e-mail 

messages and events.  These include Filters, Spotlights and Searches.  Finding a message 

by sorting using “Arrange By” has already been discussed. 

 Entourage Quick Filter provides an instant search capability on the following 

items: 

 

 Subject 

 From 

 To 

 Category is 

 Project is 

 

 Your filtering is based on based on matching a message’s “Subject” or other items 

that “Starts With” or “Contains” text you type in.  If you vaguely remember a message 

with the subject “musical instruments”, for instance, you can first see if the subject “starts 

with” that phrase, and then you can see if the words appear in the middle of the subject.   

 

 
 

Figure 27: Quick Filter 
 

  

 The Spotlight search, a capability built into OSX, enables you to search any 

content in your e-mail or on your computer.  To find a message, simply type some words 

that are likely to be in the message you’re looking for.  Your options will almost instantly 

appear if you have a smaller mailbox. 
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Figure 28:  Spotlight 

 

Out of Office    

 

 An often-requested feature for Entourage 2008, the Out of Office assistant works 

for you when you are not available to answer your e-mail messages in a timely manner.    

Go to ToolsOut of Office Assistant to bring up the program. All e-mails received will 

be automatically responded to even if you are logged out of Entourage.  However, 

Exchange will respond only once to each e-mail sender with the “Out of Office 

Message”. 

 

 
Figure 29:  Out Of Office Assistant 

 
 If you are in need of a wider variety of responses, you can use Entourage ToolsRules 
to set up responses other than simply replying to e-mail messages, such as forwarding e-mail 
messages from specific individuals as well as performing “Out of Office” activities.  Entourage 
must be running on your workstation for this to work correctly. The best source of this sort of 
information is to do a “Google” search for “out of office” rules for Entourage. 
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Creating and Restoring Archives    

 

Entourage has a built-in archiving capability.  Select FileExport to activate the 

Export menu.   You can export Mail, Tasks, Local Contacts, Notes and Local Calendar 

events.   Note that you can archive items by category, such as all e-mail associated with a 

project. However, you cannot archive items by date.  You cannot export group 

information directly.   Then, click on Next.  After that, you have the choice to keep items 

in Entourage after they are archived.   

 

 
 

Figure 30:  Exporting Message Archives 

 

You will then get a choice in which file to archive your Entourage content.   The 

default file extension is “RGE”.  Please choose and appropriate filename to ensure proper 

identification and retrieval of the archive later. 

 

 
Figure 31: Saving Entourage Archives 
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Restoring Entourage content requires going to FileImport and loading the 

appropriate “RGE” file. Here are a couple of tips from the UCSF information retrieving 

and examining Entourage archives: 

 If you need to refer to information stored in an archive temporarily. Create a new 
identity and import the information into it. Then, when you are finished, you can 
simply delete the new identity.  

 If you want to explore the contents of an archive, CONTROL+click the .rge folder 
and then click Show Package Contents.  

Junk Mail   

 

 Entourage automatically can handled messages flagged as Junk Mail by the 

Exchange server. You have a choice as to the level of Junk Mail filtering by going to 

ToolsJunk E-mail Protection, including none, low, high and exclusive.  In addition, 

you can identify “Safe Domains” and designate “Blocked Users”.   The screenshot of 

Junk E-mail Protection is self-explanatory. 

 

 
Figure 32: Junk E-mail Protection 

 

Flagging Messages as “To Do” list   
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 Flagging a message as a To Do list item is very easy.  While Entourage does 

*not* archive tasks, it does archive “To Do” list items that have been flagged through E-

mail.  On a message, simply click on the flag field.  Set the due date by going to 

EditTo Do and specifying today, tomorrow, this week, next week or choose a date.  

You can add reminders or mark the item as complete.    

 

 
Figure 33:  To Do Item 

 

Empty Deleted Items Folder   

 

You can empty the Deleted Items folder manually or automatically.  To empty it 

manually, simply type CTRL-Click on the Deleted Items folder and it will be emptied 

after you select Empty Deleted Items.  To delete the contents of Deleted Items on the 

Exchange Server automatically, go to Run Schedule at ToolsRun ScheduleEmpty 

Deleted Items Folder and select Edit Schedule. You must select the Deleted Items 

(Exchange) folder on the Exchange server.  By default, Entourage just cleans up the 

Deleted Items folder on the local computer. 

Tasks   
 

 Entourage provides two different ways to keep up with daily “to do” items or 

goals.   One is Tasks; the other is the To Do List.  To distinguish between them, 

Entourage Tasks includes all items assigned to yourself that have been created through 

Tasks.  The To Do List includes all tasks created for yourself, plus e-mails that you have 

flagged.   

 

 To start tasks, simply click on the Task View Button.   The Tasks window has 

interesting and useful features that are worth noting: 

 

 Toolbar functions:  New (Task), Status and Due Date filters, To Do, 

Categories 

 Folder:  View Tasks, To Do List, or Task Views 

 Filter:  Can filter on name of task, task category or project. 
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Figure 34:  Tasks 

 

 Creating an Entourage task is very easy.  Simply click on the New Entourage 

toolbar icon, name the task, set a start date, a reminder date, a priority and whether or not 

this task occurs once or repeatedly.   You can add task notes.  The screenshot illustrates 

this best. 

 

 
Figure 35:  Task Creation 

 

 Once tasks are created, click on the Status or Due Date toolbar icons to see 

whether or not tasks or complete, or if they are due today or next week.  Use the “To Do” 

toolbar icon to set a due date, and use the “Categories” icon to assign a category to a task 

for sorting purposes.  You can sort tasks easily by clicking on Task Views based on a 

number of categories, including priority, “Incomplete”, “due today”, etc. 

 

 The steps for To Do List items are identical, except there will be an additional 

column displayed called Folder.  If the folder says “Inbox”, the task is tracked on the 

server and can be accessed by Entourage, Outlook or Outlook Web Access anywhere on 

or off-campus. Likewise, the To Do List items will appear on the My Day window, 



Getting Started with Entourage  32 

providing a convenient summary of your priorities, even when you are currently working 

on something else, such as E-mail.  

 

  While Tasks and To Do List items are not stored on the server, flagged e-mails 

are, and you can set and/or change due dates.  (If you strongly rely upon the task manager 

for your daily work, as opposed to using the Exchange Calendar through Entourage, it is 

important to make sure that your computer is regularly backed up in case your computer 

breaks or information is accidentally deleted from your workstation.) 

  

Address Book   
 

Entourage in the Exchange environment provides access to several different 

Address Books from which you can obtain valid e-mail addresses for your organizations 

. 

 Personal Address Book (Stored Locally) 

 Contacts (on Austin Exchange) 

 Global Address List or GAL (from Austin Exchange Server) 

 UT Austin LDAP directory 

 

This means that you have access to four different sources of E-mail address 

information, all of which are available when configured correctly for composing a 

message.   When Entourage is configured to work with Austin Exchange servers, you will 

have access to the Global Address List and the Contacts list.  If the item, Directory 

(LDAP), does not appear on your list of available address lists, your technical support 

staff  will need to follow additional instructions for accessing the  UT Austin LDAP 

server which can be found on the ITS Messaging Answers page at 

http://www.utexas.edu/its/messaging/answers/index.php.   

 

 

 
 

Figure 36:  Selecting Your Address Book When Composing a Message 

 

 

Normally, on AEMS, you will use Entourage Contacts (Address Book) to store 

contact information for your friends, family, and business associates.  Access the 

Contacts console in Entourage by clicking on the Address Book icon which is one of the 

Entourage View Buttons.  The Address Book window displays a list of contacts in the 

upper portion of the window and has a preview pane in the lower portion by default.  

(Restore this by going to ViewPreview Pane if this option disappears.) You can sort 

http://www.utexas.edu/its/messaging/answers/index.php
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the list by clicking column headings, and you can double-click a row to open the details 

for a contact.  

 

Creating a Contact  

 

1. Click Address Book.   

2. Click New.   

3. In the Create Contact dialog box, enter the 

information you want for the contact.  

4. To save this contact and close the Create 

Contact dialog box, click Save & Close.   

5. To enter more information about this 

contact, click More and then enter any 

additional information you want and save 

the information entered. 

 

 Remember, if the person whose contact 

information you are entering is an Austin 

Exchange subscriber, you need to make sure 

that you are using the correct e-mail address, or 

you will have difficulty inviting this person to a 

meeting since you will not be able to see 

his/her “Free/Busy” information. 

 

 

 

   

 

 

 

Figure 36:  Address Book Contact Creation 
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Creating a Group In Your Address Book    

 

In Entourage, you can create groups of contacts so that you can address an e-mail 

message to multiple people by group name.  However, group information is not stored on 

the Austin Exchange server.  Groups are stored in your Address Book [On My 

Computer]. 

 

1. In the Address Book, click on Address Book. 

 

 

2. Click on NewGroup by clicking on the New Icon on the Entourage Toolbar.  

3. Name the group.  

4. Click in the “+” sign add e-mail addresses to the group.    

5. Close the window to save the group.  You will be prompted to save group 

information. 

 

 
Figure 37:  E-Mail Group Creation 

 

 

The group name will appear in your Address Book on your computer and on your 

contact list, will have a “Double-Person” icon.  Remember, Entourage 2008 cannot (yet) 

save groups on the Austin Exchange server.  Keep checking, since this is a highly 

requested feature. 
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Using the Address Book   

 

 When composing a message you can retrieve previously used E-mail 

addressed from Entourage automatically. When you begin typing in a name or address, 

Entourage will automatically suggest any matches from your address book or from 

previously entered e-mail addresses that you may not have ever entered into the book.  If 

you see the address you are looking for, click on it with your mouse and it will be added 

to the field. 

 

You can also display your address book while composing a message by clicking 

on the Contacts icon when adding addresses to the To, CC, or BCC fields. All addresses 

stored in your Contacts on Austin Exchange will be listed.  You can type in portions of 

names in order to find the name you are looking for. Add addresses by clicking and 

dragging them into the appropriate field or by doubling clicking on an address. 

 

 
Figure 38:  Entourage Local Address Book 

 

 Please remember to select Contacts when using your address book stored on the 

server. If you need to communicate with someone not on your address book who is a 

member of the UT Austin community, select Default Global Address List or the 

Directory (LDAP).   To use e-mail Groups in Entourage, you must select Address Book 

(On My Computer) to see them.   
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Appendix A 

Checking Your Quota on Austin Exchange Services (AEMS) 

 

Everyone on the Austin Exchange Email System has a disk storage quota assigned to 

their account.   Departments normally use TRAC to change the disk quotas for specific 

individuals.  In order to check your quota, do the following steps: 

 

1.  Click on the Exchange folder stored on the Exchange server.  That is the one just 

above the Exchange Inbox in the folder list. 

2. Now, right-click or enter ControlClick to get an Entourage submenu that can be 

used to work with quotas. 

 

 
 

Figure:  Right-Click on Exchange Server Folder 

 

 

3. In Folder Properties, click on the Storage tab and you will see the disk space 

taken up by each folder on the server. You can identify the folders that have 

excessive disk space and can be removed after making copies of the contents.  

Alternatively, you can save files onto the local “My Computer” folders in 

Entourage and then Archive them to external files using Entourage Archiving. 
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Figure:  Folder Properties And Disk Space Usage 


